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This document describes operations of the Cisco Transport Controller (CTC), the software interface for
Cisco ONS 15454, Cisco ONS 15454 M2, and Cisco ONS 15454 M6 shelf assemblies. For CTC setup
and login information, refer to the “Connect the PC and Log into the GUI” document.

This document also describes the CTC views, menus options, tool options, shortcuts, table display
options, and the shelf inventory data presented in CTC.

This document is applicable to software R9.4 and earlier releases. For software R9.6.x and later releases,
see the CTC Enhancements, Operations, and Shortcuts document.

Unless otherwise specified, ONS 15454, ONS 15454 M2, and ONS 15454 M6 refers to both ANSI and
ETSI shelf assemblies.

If network discovery is enabled on the node, CTC searches each node in the network for more recent
versions of the CTC software. If a more recent version is discovered, CTC gives you the option of
downloading the Java archive (JAR) files to your PC.

The LBAND cards are not supported in ONS 15454 M2 and ONS 15454 M6 chassis.

Document topics include:
e CTC Software Delivery Methods, page 2
e CTC Installation Overview, page 3
e PC and UNIX Workstation Requirements, page 4
e ONS 15454 Connections, page 6
e CTC Window, page 8
e Using the CTC Launcher Application to Manage Multiple ONS Nodes, page 19

Americas Headquarters:
Cisco Systems, Inc., 170 West Tasman Drive, San Jose, CA 95134-1706 USA


http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_ctc_operations.html

Il CTC Software Delivery Methods

e TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card Reset, page 22

e TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card Database, page 23
e Software Revert, page 24

e Multishelf and Single-Shelf Modes, page 24

e Display CTC Views, page 24

¢ Node Icons on the Network View Map, page 26

e Manage the CTC Window, page 29

e Equipment Inventory, page 38

e Facilities View, page 39

CTC Software Delivery Methods

ONS 15454, ONS 15454 M2, and ONS 15454 M6 provisioning and administration is performed using
the CTC software. CTC is a Java application that resides on the control cards:
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE. CTC is downloaded to your workstation the first time
you log into 15454-DWDM, 15454-M2, or 15454-M6 shelf assemblies with a new software release using
the web interface. You can also log into CTC using the CTC launcher application (StartCTC.exe). Refer
to the “Using the CTC Launcher Application to Manage Multiple ONS Nodes” section on page 19 for
more information.

CTC Software Installed on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card

The CTC software is preloaded on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards; therefore,
you do not need to install software on these cards. When a new CTC software version is released, use
the release-specific software upgrade document to upgrade the ONS 15454, 15454-M2, or 15454-M6
software on the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards.

When you upgrade the CTC software, the control cards store the new CTC version as the protect CTC
version. When you activate the new CTC software, the control cards store the older CTC version as the
protect CTC version, and the newer CTC release becomes the working version. You can view the
software versions that are installed on an ONS 15454, 15454-M2, or 15454-M6 shelf assemblies by
selecting the Maintenance > Software tabs in node view (single-shelf mode) or multishelf view
(multishelf mode).

Select the Maintenance > Software tabs in network view to display the software versions installed on all
the network nodes.

CTC Software Installed on the PC or UNIX Workstation

CTC software is downloaded from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards and installed
on your computer automatically after you connect to the ONS 15454, 15454-M2, or 15454-M6 with a
new software release for the first time. Downloading the CTC software files automatically ensures that
your computer is running the same CTC software version as the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards you are accessing. The CTC files are stored in the
temporary directory designated by your computer operating system. Click the Delete CTC Cache button
to remove files stored in the temporary directory. If the files are deleted, they download the next time
you connect to ONS 15454, 15454-M2, or 15454-M6. Downloading the Java archive (JAR) files for CTC

PCTC Operation, Information, and Shortcuts



Note

CTC Installation Overview W

takes several minutes depending on the bandwidth of the connection between your workstation and ONS
15454, 15454-M2, or 15454-M6. For example, JAR files downloaded from a modem or a data
communications channel (DCC) network link require more time than JAR files downloaded over a LAN
connection.

During network topology discovery, CTC polls each node in the network to determine which one
contains the most recent version of the CTC software. If CTC discovers a node in the network that has
a more recent version of the CTC software than the version you are currently running, CTC generates a
message stating that a later version of the CTC has been found in the network and offers to install the
CTC software upgrade. After the node view appears, you can upgrade CTC by using the Tools >
Update CTC menu option. If you have network discovery disabled, CTC will not seek more recent
versions of the software. Unreachable nodes are not included in the upgrade discovery.

Upgrading the CTC software will overwrite your existing software. You must restart CTC after the
upgrade is complete.

CTC Installation Overview

Note

To connect to ONS 15454, 15454-M2, or 15454-M6 using CTC, you enter the IP address in the URL
field of Microsoft Internet Explorer. After connecting to ONS 15454, 15454-M2, or 15454-M6, the
following occurs automatically:

1. A CTC launcher applet is downloaded from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card
to your computer.

2. The launcher determines whether your computer has a CTC release matching the release on the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

3. If the computer does not have CTC installed, or if the installed release is older than the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card’s version, the launcher downloads the CTC
program files from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card.

4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web
browser is no longer needed. Always log into nodes having the latest software release. If you log
into an ONS 15454, 15454-M2, or 15454-M6 that is connected with older versions of CTC, or to
Cisco ONS 15327s or Cisco ONS 15600s, CTC files are downloaded automatically to enable you to
interact with those nodes. The CTC file download occurs only when necessary, such as during your
first login. You cannot interact with nodes on the network that have a software version later than the
node that you used to launch CTC.

Each ONS 15454, 15454-M2, or 15454-M6 can handle up to five concurrent CTC sessions. CTC
performance can vary, depending upon the volume of activity in each session, network bandwidth, and
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card load.

You can also use TL1 commands to communicate with ONS 15454, 15454-M2, or 15454-M6 through
VT100 terminals and VT100 emulation software, or you can telnet to ONS 15454, 15454-M2, or
15454-M6 using TL1 ports 2361 and 3083. Refer to the Cisco ONS SONET TLI Command Guide or
Cisco ONS SDH TL1 Command Guide for a comprehensive list of TL1 commands.
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PC and UNIX Workstation Requirements

To use CTC for ONS 15454, 15454-M2, or 15454-M6, your computer must have a web browser with the
correct Java Runtime Environment (JRE) installed. The correct JRE for each CTC software release is
included on the ONS 15454, 15454-M2, or 15454-M6 software CD. If you are running multiple CTC
software releases on a network, the JRE installed on the computer must be compatible with the different
software releases.

When you change the JRE version on the JRE tab, you must exit and restart CTC for the new JRE version
to take effect. Table 1 shows JRE compatibility with ONS 15454 software releases.

Table 1 JRE Compatibility
JRE1.2.2 JRE1.3 JRE1.4 JRES.0 JRE 1.6 JRE1.7

ONS Software Release Compatible Compatible Compatible Compatible Compatible Compatible
ONS 15454 Release 4.5 |No Yes No No No No
ONS 15454 Release 4.6 |No Yes Yes No No No
ONS 15454 Release 4.7 |No No Yes No No No
ONS 15454 Release 5.0 |No No Yes No No No
ONS 15454 Release 6.0 |No No Yes No No No
ONS 15454 Release 7.0 |No No Yes Yes No No
ONS 15454 Release 7.2  |No No Yes Yes No No
ONS 15454 Release 8.0 |No No No Yes No No
ONS 15454 Release 8.5 |No No No Yes No No
ONS 15454 Release 9.0 |No No No Yes No No
ONS 15454 Release 9.1 |No No No Yes No No
ONS 15454 Release 9.2 |No No No No Yes Yes
ONS 15454 Release 9.2.1 |No No No No Yes Yes
ONS 15454 Release 9.3 |No No No No Yes Yes
ONS 15454 Release 9.4 |No No No No Yes Yes

~

Note

To avoid network performance issues, Cisco recommends managing a maximum of 50 nodes

concurrently with CTC. The 50 nodes can be on a single DCC or split across multiple DCCs. Cisco does
not recommend running multiple CTC sessions when managing two or more large networks.

To manage more than 50 nodes, Cisco recommends using Cisco Transport Manager (CTM). If you do
use CTC to manage more than 50 nodes, you can improve performance by adjusting the heap size; see
the “General Troubleshooting” chapter of the Cisco ONS 15454 DWDM Troubleshooting Guide. You
can also create login node groups; see the “Connect the PC and Log into the GUI” document.

Table 2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java plug-in
is also included on the ONS 15454 software CD.
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PC and UNIX Workstation Requirements

Table 2 Computer Requirements for CTC
Area Requirements Notes
Processor Pentium 4 processor or equivalent A faster CPU is recommended if your
(PC only) workstation runs multiple applications
or if CTC manages a network with a
large number of nodes and circuits.
RAM 1 GB RAM or more A minimum of 1 GB is recommended if
your workstation runs multiple
applications or if CTC manages a
network with a large number of nodes
and circuits.
Hard drive 20 GB hard drive with 250 MB of free space |CTC application files are downloaded
required from the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/
TSCE to your computer. These files
occupy around 100MB (250MB to be
safer) or more space depending on the
number of versions in the network.
Operating e PC: Windows 2000, Windows XP, Use the latest Patch/Service Pack
System Windows Vista, Windows 7, Windows |released by the OS vendor. Check with
Server 2003, Windows Server 2008 the vendor for the information about the
e Workstation: Solaris Version 9 or 10 on latest Patch/Service Pack.
an UltraSPARC-III or faster processor,
with a minimum of 1 GB RAM and 250
MB of available hard drive space
e Apple Mac OS X. CTC needs to be
installed using the Cachelnstaller
available on the CCO or the ONS CD
JavaRuntime |JRE 1.6 JRE 1.6 is installed by the CTC
Environment Installation Wizard included on the ONS

15454, 15454-M2, or 15454-M6
software CD. JRE 1.6 provides
enhancements to the CTC’s
performance, especially for large
networks with numerous circuits.

We recommend that you use JRE 1.6 for
networks with Software R9.2 and later
nodes. If CTC must be launched directly
from nodes running software R7.0 or
R7.2, we recommend JRE 1.4.2 or JRE
5.0. If CTC must be launched directly
from nodes running software R5.0 or
R6.0, we recommend JRE 1.4.2. If CTC
must be launched directly from nodes
running software earlier than R5.0, we
recommend JRE 1.3.1_02.

| oL-25021-01
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Table 2 Computer Requirements for CTC (continued)
Area Requirements Notes
Web browser | ¢ PC: Internet Explorer 6.x, 7.x, 8.X For the PC, use JRE 1.6 with any
e UNIX Workstation: Mozilla 1.7 supported web browser.
e Mac OS-X PC: Safari The supported browser can be
downloaded from the Web.
Cable User-supplied CAT-5 straight-through cable |—

with RJ-45 connectors on each end to
connect the computer to ONS 15454,
15454-M2, or 15454-M6 directly or through
a LAN.

User-supplied cross-over CAT-5 cable to the
DCN port on the ONS 15454 patch panel or
to the Catalyst 2950 (multishelf mode).

ONS 15454 Connections

Note

You can connect to the ONS 15454, 15454-M2, or 15454-M6 shelf assemblies in multiple ways.

(ONS 15454) You can connect your PC directly to the ONS 15454 shelf using the RJ-45(LAN) port on
the faceplate of TCC2/TCC2P/TCC3 card or using the backplane RJ-45 LAN port.

(ONS 15454 M6) You can connect your PC directly to the ONS 15454 M6 shelf using the RJ-45(LAN)
port on the faceplate of TNC/TNCE/TSC/TSCE card or using the EMS RJ-45 port or using the RJ-45

Craft port. The EMS RJ-45 port and RJ-45 Craft port are present on the external connection unit (ECU).

(ONS 15454 M2) You can connect your PC directly to the ONS 15454 M2 shelf using the RJ-45(LAN)

port on the faceplate of TNC/TNCE/TSC/TSCE card or using the EMS RJ-45 port on the power module.

For the ANSI shelf, you can connect using the LAN pins on the backplane (the ETSI shelf provides a
LAN connection through the RJ-45 jack on the MIC-T/C/P Front Mount Electrical Connection
[FMEC]). Alternatively, you can connect your PC to a hub or switch that is connected to the ONS 15454,
connect to the ONS 15454 through a LAN or modem, or establish TL.1 connections from a PC or TL1
terminal. Table 3 lists the connection methods and requirements for ONS 15454, 15454-M2, or
15454-M6 shelves.

The TNC/TNCE/TSC/TSCE card supports multi-shelf connections through three FE RJ45 connections
on the ECU. The TNC and TNCE cards support one GE connection for CRS-1 router through the SFP
port on the card. This SFP port can act as a secondary OSC supporting only FE and GE interfaces.
The TNC/TNCE/TSC/TSCE card in ONS 15454 M6 shelf can connect to CTC through the EMS RJ-45
port or Craft port on the ECU. The TNC/TNCE/TSC/TSCE card in ONS 15454 M2 shelf can connect to
CTC through the EMS RJ-45 port on the power module.
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Table 3 Connection Methods for ONS 15454, ONS 15454 M2, and ONS 15454 M6
Method Description Requirements
Local craft |Refers to onsite network connections If you do not use Dynamic Host

between the CTC computer and the ONS Configuration Protocol (DHCP), you must
15454, 15454-M2, or 15454-M6 using one of |change the computer IP address, subnet
the following: mask, and default router, or use automatic

e The RJ-45 (LAN) port on the host detection.
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/
TSCE card

e The RJ-45 (LAN) port on the patch panel
(multishelf mode)

e Port 23 or 24 of the Catalyst
3560-V2-24TS-SD and 2950 (multishelf
mode)

e The LAN pins on the 15454-DWDM
backplane (ANSI)

e The RJ-45 jack on the MIC-T/C/P
FMEC (ETSI)

e (ONS 15454 M6) EMS RJ-45 port on the
ECU

e (ONS 15454 M6) RJ-45 Craft port on the
ECU

e (ONS 15454 M2) EMS RJ-45 port on the
power module

e A hub or switch to which the ONS 15454
is connected

Corporate |Refers to a connection to the ONS 15454, e The ONS 15454, 15454-M2, or
LAN 15454-M2, or 15454-M6 through a corporate 15454-M6 must be provisioned for
or network operations center (NOC) LAN. LAN connectivity, including IP
address, subnet mask, and default
gateway.

e The ONS 15454, 15454-M2, or
15454-M6 must be physically
connected to the corporate LAN.

e The CTC computer must be connected
to the corporate LAN that has
connectivity to ONS 15454,
15454-M2, or 15454-M6.
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Table 3

Connection Methods for ONS 15454, ONS 15454 M2, and ONS 15454 M6

Method

Description

Requirements

TL1

Refers to a connection to the ONS 15454,
15454-M2, or 15454-M6 using TL1 rather
than CTC. TL1 sessions can be started from
CTC, or you can use a TL1 terminal. The
physical connection can be a craft
connection, corporate LAN, or a TL1
terminal.

Refer to the Cisco ONS SONET TL1
Reference Guide or the Cisco ONS SDH
TLI Reference Guide.

Remote

Refers to a connection made to the ONS
15454, 15454-M2, or 15454-M6 using a
modem.

¢ A modem must be connected to the
ONS 15454, 15454-M2, or 15454-M6.

e The modem must be provisioned for
the ONS 15454, 15454-M2, or
15454-M6. To run CTC, the modem
must be provisioned for Ethernet
access.

CTC Window

When you log into a single-shelf ONS 15454, 15454-M2, or 15454-M6, the CTC window appears in
node view (Figure 1). When you log into a multishelf ONS 15454 or 15454-M6, meaning that two or
more ONS 15454 or 15454-M6 shelves are configured to operate as one node, the multishelf view
(Figure 2) appears in the CTC window. The window includes a menu bar, a toolbar, and a top and bottom
pane. The top pane provides status information about the selected objects and a graphic of the current
view. The bottom pane provides tabs and subtabs to view ONS 15454 information and perform ONS
15454 provisioning and maintenance tasks. From the CTC window, you can display the other ONS
15454 views. In single-shelf mode, these are the network, node, and card views. In multishelf mode,
these are the network, multishelf, shelf, and card views.

r PCTC Operation, Information, and Shortcuts
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Figure 1 Node View (Default Login View for Single-Shelf Mode)
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Figure 2 Multishelf View (Default Login View for Multishelf Mode)
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Summary Pane

The Summary pane on the left has the following fields:
¢ Node Addr—IP address of the node.
¢ Booted—The Booted field indicates one of the following:

— Date and time of the node reboot. The node reboot is caused by complete power cycle, software
upgrade, or software downgrade.

— Date and time of reset of the control cards one after the other.
e User—Login user name.

e Authority—Security level of users. The possible security levels are Retrieve, Maintanence,
Provisioning, and Superuser.

e  SW Version—CTC software version.

e Defaults—Name provided to identify the defaults list.

PCTC Operation, Information, and Shortcuts
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Node View (Multishelf Mode), Node View (Single-Shelf Mode), and Shelf View
(Multishelf Mode)

CTC Card Colors

Note

Note

Node view, shown in Figure 1, is the first view that appears after you log into a single-shelf ONS 15454.
Multishelf view, shown in Figure 2, is the first view that appears after you log into a multishelf

ONS 15454. The login node is the first node shown, and it is the “home view” for the session. Multishelf
view and node view allow you to manage one ONS 15454 node. The status area shows the node name;
IP address; session boot date and time; number of Critical (CR), Major (MJ), and Minor (MN) alarms;
name and security level of the current logged-in user; software version; and network element default
setup.

(ONS 15454 and ONS 15454-M6 only) In a multishelf mode, up to 30 shelves operate as a single node.

The reason for extending the number of subtending shelves to 30 is to accommodate and manage the new
optical and DWDM cards that operate in the even band frequency grid.

When you open a shelf from multishelf view, shelf view appears, which looks similar to node view but
does not contain the tabs and subtabs that are used for node-level operations.

The graphic area of the CTC window depicts the ONS 15454 shelf assembly. The colors of the cards in
the graphic reflect the real-time status of the physical card and slot (Table 4).

Table 4 Multishelf View (Multishelf Mode), Node View (Single-Shelf Mode), and Shelf View
(Multishelf Mode) Card Colors

Card Color Status

Gray Slot is not provisioned; no card is installed.

Violet Slot is provisioned; no card is installed.

White Slot is provisioned; a functioning card is installed.
Yellow Slot is provisioned; a Minor alarm condition exists.
Orange Slot is provisioned; a Major alarm condition exists.
Red Slot is provisioned; a Critical alarm exists.

On the ONS 15454 ETSI, the colors of the FMEC cards reflect the real-time status of the physical FMEC
cards. Table 5 lists the FMEC card colors. The FMEC ports shown in CTC do not change color.

You cannot preprovision FMECs.

| oL-25021-01
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Table 5

Multishelf View (Multishelf Mode) and Node View (Single-Shelf Mode) FMIEC Color

Upper Shelf FMEC Color Status

White Functioning card is installed.
Yellow Minor alarm condition exists.
Orange (Amber) Major alarm condition exists.
Red Critical alarm exists.

The wording on a card in node view (single-shelf mode) or shelf view (multishelf mode) shows the status
of a card (Active, Standby, Loading, or Not Provisioned). Table 6 lists the card statuses.

Table 6

Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Card Statuses

Card Status

Description

Act Card is active.

Sty Card is in standby mode.
Ldg Card is resetting.

NP Card is not present.

Port color in card view, node view (single-shelf mode), and shelf view (multishelf mode) indicates the
port service state. Table 7 lists the port colors and their service states. For more information about port
service states, see Administrative and Service States.

Table 7 Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Card Port Colors and Service States

Port Color Service State Description

Cyan (blue) |Out-of-Service and Management, Loopback Port is in a loopback state. On the card in node or shelf
(OOS-MA,LPBK) (ANSI) view, a line between ports indicates that the port is in

Locked-enabled,loopback (ETSI)

terminal or facility loopback (see Figure 3 and Figure 4).
Traffic is carried and alarm reporting is suppressed.
Raised fault conditions, whether or not their alarms are
reported, can be retrieved on the CTC Conditions tab or
by using the TL1 RTRV-COND command.

Cyan (blue)

Out-of-Service and Management, Maintenance Port is out-of-service for maintenance. Traffic is carried
(OOS-MA ,MT) (ANSI) and loopbacks are allowed. Alarm reporting is

Locked-enabled,maintenance (ETSI)

suppressed. Raised fault conditions, whether or not their
alarms are reported, can be retrieved on the CTC
Conditions tab or by using the TL1 RTRV-COND
command. Use this service state for testing or to suppress
alarms temporarily. Change the state to
IS-NR/Unlocked-enabled;
OOS-MA,DSBLD/Locked-enabled,disabled; or
OO0OS-AU,AINS/Unlocked-disabled,automaticInService
when testing is complete.

Gray

Out-of-Service and Management, Disabled The port is out-of-service and unable to carry traffic.
(OOS-MA,DSBLD) (ANSI) Loopbacks are not allowed in this service state.

Locked-enabled,disabled (ETSI)

PCTC Operation, Information, and Shortcuts
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Table 7 Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Card Port Colors and Service States

Port Color Service State Description

Green In-Service and Normal (IS-NR) (ANSI) The port is fully operational and performing as
Uslocket-eabied ETS1)

Violet Out-of-Service and Autonomous, Automatic The port is out-of-service, but traffic is carried. Alarm

In-Service (OOS-AU,AINS) (ANSI)
Unlocked-disabled,automaticInService (ETSI)

reporting is suppressed. The node monitors the ports for
an error-free signal. After an error-free signal is detected,
the port stays in this service state for the duration of the
soak period. After the soak period ends, the port service
state changes to IS-NR/Unlocked-enabled.

Raised fault conditions, whether or not their alarms are
reported, can be retrieved on the CTC Conditions tab or
by using the TL1 RTRV-COND command. The AINS
port will automatically transition to
IS-NR/Unlocked-enabled when a signal is received for
the length of time provisioned in the soak field.

Figure 3 Terminal Loopback Indicator

Figure 4 Facility Loopback Indicator

Multishelf View Card Shortcuts

If you move your mouse over cards in the multishelf view graphic, popups display additional information
about the card including the card type; the card status (active or standby); the type of alarm, such as
Critical, Major, or Minor (if any); the alarm profile used by the card; and for transponder (TXP) or
muxponder (MXP) cards, the wavelength of the dense wavelength division multiplexing (DWDM) port.

Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Card Shortcuts

If you move your mouse over cards in the node view (single-shelf mode) or shelf view (multishelf mode)
graphic, pop-ups display additional information about the card including the card type; the card status
(active or standby); the type of alarm, such as Critical, Major, or Minor (if any); the alarm profile used
by the card; and for TXP or MXP cards, the wavelength of the DWDM port. Right-click a card to reveal
a shortcut menu, which you can use to open, reset, delete, or change a card. Right-click a slot to
preprovision a card (that is, provision a slot before installing the card).
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Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Port Shortcuts

If you move your mouse over the ports in the node view (single-shelf mode) or shelf view (multishelf
mode), the popup message displays information about the port type, service state, and the alarm profile
used by the port. For example, the popup message displays “((EXP-RX-1-4) Service State: IS-NR,
Alarm Profile: Inherited)”.

Card View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Port Shortcuts

If you right-click the ports in the card view (single-shelf mode or multishelf mode), the popup message
displays the side information along with shelf, slot, and port information. For example, the popup
message displays “Shelf 1, Slot 3 (40 SMR2 C), Port EXP-TX 1-1, Side C”.

Multishelf View Tabs

Table 8 lists the tabs and subtabs available in the multishelf view. The actions on these tabs apply to the
multishelf node and its subtending shelves.

Table 8

Multishelf View Tabs and Subtabs

Tab

Description

Subtabs

Alarms

Lists current alarms (CR, MJ, MN) for the
multishelf node and updates them in real time.

Conditions

Displays a list of standing conditions on the
multishelf node.

History

Provides a history of multishelf node alarms
including the date, type, and severity of each
alarm. The Session subtab displays alarms and
events for the current session. The Node subtab
displays alarms and events retrieved from a
fixed-size log on the node.

Session, Node

Circuits

Creates, deletes, edits, and maps circuits.

Circuits, Rolls

Provisioning

Provisions the ONS 15454 multishelf node.

General, Network, OSI, Security,
SNMP, Comm Channels, Alarm
Profiles, Defaults, WDM-ANS

Inventory

Provides inventory information (part number,
serial number, and Common Language
Equipment Identification [CLEI] codes) for
cards installed on all shelves in the multishelf
node. Allows you to delete and reset cards and
change the card service state.

Maintenance

Performs maintenance tasks for the multishelf
node.

Database, Network, OSI, Software,
Diagnostic, Audit, DWDM

Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Tabhs

Table 9 lists the tabs and subtabs available in node view (single-shelf mode) or shelf view (multishelf

mode).
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CTC Window W

Node View (Single-Shelf Mode) or Shelf View (Multishelf Mode) Tabs and Subtabs

Tab

Description

Subtabs

Alarms

Lists current alarms (CR, MJ, MN) for the node
or shelf and updates them in real time.

Conditions

Displays a list of standing conditions on the
node or shelf.

History

Provides a history of node or shelf alarms
including the date, type, and severity of each
alarm. The Session subtab displays alarms and
events for the current session. The Node subtab
displays alarms and events retrieved from a
fixed-size log on the node.

Session, Node

Circuits

Creates, deletes, edits, and maps circuits.

Circuits, Rolls

Provisioning

Provisions the ONS 15454 single-shelf or
multishelf node.

Single-shelf mode: General,
Network, OSI, Security, SNMP,
Comm Channels, Alarm Profiles,
Defaults, WDM-ANS

Multishelf mode: General,
Protection, Timing, Alarm Profiles

Inventory

Provides inventory information (part number,
serial number, and CLEI codes) for cards
installed in the single-shelf or multishelf node.
Allows you to delete and reset cards and change
the card service state.

Note Each card has bootstrap and boot code.
After the card is upgraded using the boot
code upgrade procedure, the bootstrap
version is displayed in the Inventory tab
in CTC; However, the boot code version
is not displayed in the Inventory tab.

Maintenance

Performs maintenance tasks for the single-shelf
or multishelf node.

Single-shelf mode: Database,
Network, OSI, Software,
Diagnostic, Audit, DWDM

Multishelf mode: Protection,
Overhead XConnect, Diagnostic,
Timing

Network View

Network view allows you to view and manage ONS 15454, 15454-M2, or 15454-M6 that have DCC
connections to the node that you logged into and any login node groups you have selected (Figure 5).
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Figure 5 Network in CTC Network View
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Note  Nodes with DCC connections to the login node do not appear if you checked the Disable Network
Discovery check box in the Login dialog box.

The graphic area displays a background image with colored ONS 15454 icons. A Superuser can set up
the logical network view feature, which enables each user to see the same network view.

Network View Tabs

Table 10 lists the tabs and subtabs available in network view.

Table 10 Network View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the —
network and updates them in real time.

Conditions Displays a list of standing conditions on the —
network.

History Provides a history of network alarms including |—

date, type, and severity of each alarm.

Circuits Creates, deletes, edits, filters, and searches for |—
network circuits.
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Table 10 Network View Tabs and Subtabs (continued)

Tab Description Subtabs

Provisioning |Provisions security, alarm profiles, Security, Alarm Profiles, BLSR
bidirectional line switched rings (BLSRs) (ANSI), MS-SPRing (ETSI),
(ANSI), multiplex section-shared protection Overhead Circuits, Provisionable
rings (MS-SPRing) (ETSI), and overhead Patchcords
circuits.

Maintenance |Displays the type of equipment and the status |Software
of each node in the network; displays working
and protect software versions; and allows
software to be downloaded.

CTC Node Colors
The color of a node in network view, shown in Table 11, indicates the node alarm status.
Table 11 Node Status Shown in Network View
Color Alarm Status
Green No alarms
Yellow Minor alarms
Orange Major alarms
Red Critical alarms
Gray with Node initializing for the first time (CTC displays Unknown# because CTC has
Unknown# not discovered the name of the node yet)

DCC Links

The lines show DCC connections between the nodes (Table 12). DCC connections can be green (active)
or gray (fail). The lines can also be solid (circuits can be routed through this link) or dashed (circuits
cannot be routed through this link). Circuit provisioning uses active/routable links. Selecting a node or
span in the graphic area displays information about the node and span in the status area.

Table 12 DCC Colors Indicating State in Network View

Color and Line Style State

Green and solid Active/Routable
Green and dashed Active/Nonroutable
Gray and solid Failed/Routable
Gray and dashed Failed/Nonroutable

Link Consolidation

CTC provides the ability to consolidate the DCC, generic communications channel (GCC), optical
transmission section (OTS), and PPC links shown in the network view into a more streamlined view.
Link consolidation allows you to condense multiple inter-nodal links into a single link. The link

PCTC Operation, Information, and Shortcuts
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Note

Card View

Note

consolidation sorts links by class, meaning that all DCC links are consolidated together, for example.You
can access individual links within consolidated links using the right-click shortcut menu.Each link has
an associated icon (Table 13).

Table 13 Link Icons

Icon Description
DCC icon

GCC icon

OTS icon

PPC icon

B & > p

Link consolidation is only available on non-detailed maps. Non-detailed maps display nodes in icon
form instead of detailed form, meaning that the nodes appear as rectangles with ports on the sides. Refer
to the Cisco ONS 15454 DWDM Configuration Guide for more information about consolidated links.

The card view provides information about individual ONS 15454 cards. Use this window to perform
card-specific maintenance and provisioning. A graphic showing the ports on the card is shown in the
graphic area. The status area displays the node name, slot, number of alarms, card type, equipment type,
card status (active or standby), card service state if the card is present, and port service state (described
in Table 7 on page 12). The information that appears and the actions that you can perform depend on the
card. For more information about card service states, refer to Administrative and Service States.

CTC provides a card view for all cards except the TCC2/TCC2P/TCC3/TSC/TSCE cards.

Use the card view tabs and subtabs shown in Table 14 to provision and manage the ONS 15454. The
subtabs, fields, and information shown under each tab depend on the card type selected.

Table 14 Card View Tabs and Subtabs
Tab Description Subtabs
Alarms Lists current alarms (CR, MJ, MN) for the card |—
and updates them in real time.
Conditions Displays a list of standing conditions on the —
card.

PCTC Operation, Information, and Shortcuts
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Table 14 Card View Tabs and Subtabs (continued)
Tab Description Subtabs
History Provides a history of card alarms including Session (displays alarms and events

date, object, port, and severity of each alarm. |for the current session), Card
(displays alarms and events retrieved
from a fixed-size log on the card)

Circuits Creates, deletes, edits, and search circuits. —

Provisioning |Provisions an ONS 15454 card. DS-N and OC-N cards: Line, Line
Thresholds (different threshold
options are available for DS-N and
OC-N cards), Elect Path Thresholds,
SONET Thresholds, SONET STS,
Alarm Profiles

TXP and MXP cards: Card, Line,
Line Thresholds, Optics Thresholds,
OTN, Alarm Profiles

DWDM cards (subtabs depend on
card type): Optical Line, Optical
Chn, Optical Amplifier, Parameters,
Optics Thresholds, Alarm Profiles

Maintenance |Performs maintenance tasks for the card. Loopback, Info, Protection, J1 Path
Trace, AINS Soak (options depend
on the card type), Automatic Laser
Shutdown

Performance |Performs performance monitoring for the card. |DS-N and OC-N cards: no subtabs

(Not available TXP and MXP cards: Optics PM,
for the AIC-I Payload PM, OTN PM
cards) DWDM cards (subtabs depend on

card type): Optical Line, Optical
Chn, Optical Amplifier Line, OC3
Line, Parameters, Optics Thresholds

Inventory (40-WSS, 40-WXC, OPT-PRE and OPT-BST |—
cards) Displays an Inventory screen of the
ports.

Using the CTC Launcher Application to Manage Multiple ONS
Nodes

The CTC Launcher application is an executable file, StartCTC.exe, that is provided on

Software Release 9.2.1 CDs for Cisco ONS products. You can use CTC Launcher to log into multiple
ONS nodes that are running CTC Software Release 3.3 or higher, without using a web browser. The CTC
launcher application provides an advantage particularly when you have more than one NE version on the
network, because it allows you to pick from all available CTC software versions. It also starts more
quickly than the browser version of CTC and has a dedicated node history list.

PCTC Operation, Information, and Shortcuts
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Using the CTC Launcher Application to Manage Multiple ONS Nodes

CTC Launcher provides two connection options. The first option is used to connect to ONS NEs that
have an IP connection to the CTC computer. The second option is used to connect to ONS NEs that reside
behind third party, OSI-based GNEs. For this option, CTC Launcher creates a TL1 tunnel to transport
the TCP traffic through the OSI-based GNE.

The TL1 tunnel transports the TCP traffic to and from ONS ENEs through the OSI-based GNE. TL1
tunnels are similar to the existing static IP-over-CLNS tunnels, GRE, and Cisco IP, that can be created
at ONS NEs using CTC. (Refer to the Cisco ONS product documentation for information about static
IP-over-CLNS tunnels.) However, unlike the static IP-over-CLNS tunnels, TL1 tunnels require no
provisioning at the ONS ENE, the third-party GNE, or DCN routers. All provisioning occurs at the CTC
computer when the CTC Launcher is started.

Figure 6 shows examples of two static IP-over-CLNS tunnels. A static Cisco IP tunnel is created from
ENE 1 through other vendor GNE 1 to a DCN router, and a static GRE tunnel is created from ONS ENE 2
to the other vender, GNE 2. For both static tunnels, provisioning is required on the ONS ENEs. In
addition, a Cisco IP tunnel must be provisioned on the DCN router and a GRE tunnel provisioned on
GNE 2.

Static IP-Over-CLNS Tunnels

Central office

Other vendor
GNE 1 ONS ENE 1/
/\

N i

Tunnel
IP-over-CLNS provisioning
tunnel

Other vendor ONS ENE /m\
GNE 2 2
///””——-__\\\\\\\
< (== (==

OSI/bCC IP/DCC

Tunnel IP-over-CLNS  Tunnel
provisioning tunnel provisioning

140174

Figure 7 shows the same network using TL1 tunnels. Tunnel provisioning occurs at the CTC computer
when the tunnel is created with the CTC Launcher. No provisioning is needed at ONS NEs, GNEs, or
routers.
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TL1 tunnels provide several advantages over static IP-over-CLNS tunnels. Because tunnel provisioning
is needed only at the CTC computer, they are faster to set up. Because they use TL1 for TCP transport,

they are more secure. TL1 tunnels also provide better flow control. On the other hand, IP over CLNS

tunnels require less overhead and usually provide a slight performance edge over TL1 Tunnels
(depending on network conditions). TL1 tunnels do not support all IP applications such as SNMP and
RADIUS Authentication. Table 15 shows a comparison between the two types of tunnels.

Table 15 TL1 and Static IP-Over-CLNS Tunnels Comparison
Static
Category IP-Over-CLNS  |TL1 Tunnel Comments
Setup Complex Simple Requires provisioning at ONS NE, GNE, and DCN routers. For
TL1 tunnels, provisioning is needed at CTC computer.
Performance Best Average to Static tunnels generally provide better performance than TL1
good tunnels, depending on TL1 encoding used. LV+Binary provides
the best performance. Other encoding will produce slightly
slower TL1 tunnel performance.
Support all IP Yes No TL1 tunnels do not support SNMP or RADIUS Server IP
applications applications.
ITU Standard Yes No Only the static IP-over-CLNS tunnels meet ITU standards. TL1
tunnels are new.
Tunnel traffic control Good Very good Both tunnel types provide good traffic control
Security setup Complex No setup Static IP-over-CLNS tunnels require careful planning. Because
needed TL1 tunnels are carried by TL1, no security provisioning is
needed.
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Table 15 TL1 and Static IP-Over-CLNS Tunnels Comparison (continued)
Static

Category IP-Over-CLNS  |TL1 Tunnel Comments

Potential to breach DCN |Possible Not possible |A potential exists to breach a DCN from a DCC using IP. This

from DCC using IP. potential does not exist for TL1 tunnels.

IP route management Expensive Automatic For static IP-over-CLNS tunnels, route changes require manual
provisioning at network routers, GNEs, and ENEs. For TL1
tunnels, route changes are automatic.

Flow control Weak Strong TL1 tunnels provide the best flow control.

Bandwidth sharing Weak Best —

among multiple

applications

Tunnel lifecycle Fixed CTC session |TL1 tunnels are terminated when the CTC session ends. Static
IP-over-CLNS tunnels exist until they are deleted in CTC.

TL1 tunnel specifications and general capabilities include:

e FEach tunnel generally supports between six to eight ENEs, depending on the number of tunnels at
the ENE.

e FEach CTC session can support up to 32 tunnels.

e The TL1 tunnel database is stored locally in the CTC Preferences file available in the user's HOME
directory. The filename is CTC.ini (Windows PC) and .ctcrc (Linux, Apple MAC, and Solaris).

e Automatic tunnel reconnection when the tunnel goes down.

e Each ONS NE can support at least 16 concurrent tunnels.

TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card Reset

Note

You can soft reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card by using CTC or by physically
resetting the card (a hard reset). A soft reset reboots the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE
card and reloads the operating system and the application software. Additioncrally, a hard reset
temporarily removes power from the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card and clears all
the buffer memory.

You can apply a soft reset from CTC to either an active or standby
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card without affecting traffic. If you need to perform a
hard reset on an active TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card, put the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card into standby mode first by performing a soft reset.

Hard reset can also be performed on the TNC/TNCE/TSC/TSCE card through CTC and TL1 interface.
Before performing the hard reset, bring the TNC/TNCE/TSC/TSCE card to maintenance mode.

When you reset the standby TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card, the system traffic is not
affected. When you reset the active TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card, traffic switches
to the standby card if the standby card is present and in the ready standby state. If the standby card is not
in the ready standby state, traffic does not switch, and results in loss of system traffic and management
connectivity until the card reboots completely.
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TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card Database

Caution

~

Note

When you reset the TNC/TNCE/TSC/TSCE card on the ONS 15454 or 15454-M6 shelves in simplex
control mode, loss of management connectivity happens until the card reboots. The system traffic loss
may occur depending on the line card and traffic type.

(Cisco ONS 15454 shelf) When a CTC reset is performed on an active TCC2/TCC2P/TCC3 card, the
AIC-I card goes through an initialization process and also resets because it is controlled by the active
TCC2/TCC2P/TCC3 card.

The active and standby TNC/TSC/TNCE/TSCE cards provisioned in a multishelf node is automatically
reset every 100 days. The traffic is not affected due to this reset.

It is possible for all the TNC/TSC/TNCE/TSCE cards on a node to automatically reset simultaneously.
To avoid the automatic reset, manually reset the TNC/TSC/TNCE/TSCE cards every 90 to 95 days. It is
recommended that the reset of the TNC/TSC/TNCE/TSCE cards of a node be staggered. The user must
reset a TNC/TSC/TNCE/TSCE card, confirm proper recovery, and wait 15 minutes before resetting the
next TNC/TSC/TNCE/TSCE card. It is recommended to reset all the standby TNC/TSC/TNCE/TSCE
cards before resetting the active TNC/TSC/TNCE/TSCE cards.

See the “Reset the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card” procedure to perform a manual
reset.

TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE Card Database

Note

When dual TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards are installed in the ONS 15454,
15454-M2, or 15454-M6 shelves, each TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card hosts a
separate database; therefore, the protect card database is available if the database on the working
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card fails. You can also store a backup version of the
database on the workstation running CTC. This operation should be part of a regular ONS 15454,
15454-M2, or 15454-M6 maintenance program at approximately weekly intervals, and should also be
completed when preparing ONS 15454, 15454-M2, or 15454-M6 for a pending natural disaster, such as
a flood or fire.

The TNC and TNCE cards provide 4GB of nonvolatile database storage for communication,
provisioning, and system control. This allows full database recovery during power failure.

The configuration details are stored in the database of the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE
card. The database restore from a TNC and TNCE cards to a TSC and TSCE cards or vice versa is not
supported.

The following parameters are not backed up and restored: node name, IP address, mask and gateway, and
Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up
database with a different node name, the circuits map to the new node name. We recommend keeping a
record of the old and new node names.
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Bl Software Revert

Software Revert

When you click the Activate button after a software upgrade, the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card copies the current working database and saves itin a
reserved location in the TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE card flash memory. If later during
the upgrade you need to revert to the original working software load from the protect software load, the
saved database installs automatically. You do not need to restore the database manually or recreate
circuits.

The revert feature is useful if the maintenance window in which you were performing an upgrade closes
while you are still upgrading CTC software. You can revert to the protect software load without losing
traffic. During the next maintenance window, you can complete the upgrade and activate the new
software load.

Circuits created or provisioning done after you activate a new software load (upgrade to a higher release)
will be lost with a revert. The database configuration at the time of activation is reinstated after a revert.
(This does not apply to maintenance reverts, such as Software R5.0.1 to Software R5.0.2, because
maintenance releases retain the database during activation.)

A

Caution  Cisco does not recommend reverting after changing provisioning on the node. Depending upon the
particular provisioning, reverting in this case can be traffic affecting.

To perform a supported (non-service-affecting) revert from a software release that you have just
activated, the release you revert to must have been working at the time you first activated the new
software on that node. Because a supported revert automatically restores the node configuration at the
time of the previous activation, any configuration changes made after activation will be lost when you
revert the software. Downloading the software release that you are upgrading to a second time after you
have activated the new load ensures that no actual revert to a previous load can take place (the
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE resets, but it does not affect the traffic and does not
change your database).

Note  To perform a supported software upgrade or revert, you must consult the specific upgrade document and
release notes for the release you are upgrading to (or reverting from).

Multishelf and Single-Shelf Modes

In a DWDM configuration, CTC views can be displayed in one of two modes. If a node contains only
one shelf, the possible views are network view, node view, and card view. This is known as single-shelf
mode. In multishelf mode, a control node and subtending shelves are configured to operate as a single
node. In this mode, four views are possible: network view, multishelf view, shelf view, and card view.
Multishelf view is the home view for nodes that are configured in multishelf mode. Multishelf view
displays all of the shelves in the node. When you open a shelf from multishelf view, shelf view appears,
which looks similar to node view but does not contain the tabs and subtabs that are used for node-level
operations.

Display CTC Views

CTC provides four views of the ONS 15454, ONS 15454-M6, and the ONS network:
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If the login ONS 15454 or ONS 15454-M6 node is in multishelf mode, the multishelf view appears
when you first log into the node. This view shows a graphic of the ONS 15454 or ONS 15454-M6
racks and provides access to tabs and subtabs that you use to manage the multishelf node and its
subtending shelves.

If the login ONS 15454 or ONS 15454-M6 node is in single-shelf mode, node view appears when
you first log into an ONS 15454 or ONS 15454-M6. This view shows a graphic of the ONS 15454
or ONS 15454-M6 shelf and provides access to tabs and subtabs that you use to manage the node.
When you open a shelf from multishelf view, shelf view appears, which looks similar to node view
but does not contain the tabs and subtabs that are used for node operations.

Card view provides access to individual ONS 15454 or ONS 15454-M6 cards. This view provides a
graphic of the card and provides access to tabs and subtabs that you use to manage the card.

Network view shows all the nodes in a ring and provides access to tabs and subtabs that you use to
manage the network. A Superuser can create a network view that is identical for all users who log
into the network or users can create custom views with maps.

Users can group a subset of nodes into a domain, which is used to isolate nodes or groups of nodes
for easier maintenance and a more streamlined network view. Double-clicking a domain displays all
the nodes that are members of the domain.Nodes connected to the domain nodes are grayed out.

Table 16 lists different actions for changing CTC views.

Table 16 Change CTC Views
To Display Perform One of the Following
Multishelf view e In network view, double-click a node icon, or right-click the node and
(multishelf mode) choose Open Node from the shortcut menu.
¢ In network view, single-click a node icon, then choose Go To Selected
Object View from the View menu.
¢ From the View menu, choose Go To Other Node, then choose the node
you want from the shortcut menu.
e Use the arrows on the CTC toolbar to navigate up or down views until you
reach node view.
Node view e In network view, double-click a node icon, or right-click the node and

(single-shelf mode) or
shelf view (multishelf
mode)

choose Open Node from the shortcut menu. If the node is in multishelf
view (multishelf mode), double-click a shelf icon, or right-click and
choose Open Shelf from the shortcut menu.

In network view, single-click a node icon, then choose Go To Selected
Object View from the View menu. If the node is in multishelf mode,
double-click a shelf icon, or right-click and choose Open Shelf from the
shortcut menu.

In multishelf view (multishelf mode), double-click a shelf icon, or
right-click and choose Open Shelf from the shortcut menu.

From the View menu, choose Go To Other Node, then choose the node
you want from the shortcut menu.

Use the arrows on the CTC toolbar to navigate up or down views until you
reach node view.
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Table 16 Change CTC Views (continued)

To Display Perform One of the Following

Network view

In node view (single-shelf mode) or multishelf view (multishelf mode),
click the up arrow or the Network View tool on the CTC toolbar. If in shelf
view (multishelf mode), you must click the up arrow twice.

In multishelf view (multishelf mode), click the up arrow or the Network
View tool on the CTC toolbar.

From the View menu, choose Go To Network View.

Card view

In node view, double-click a card or right-click the card and choose
Open Card.

In node view (single-shelf mode) or shelf view (multishelf mode),
single-click a card icon, then choose Go To Selected Object View from
the View menu.

Use the arrows on the CTC toolbar to navigate up or down views. For
example, in node view, click a card, then click the down arrow.

Node Icons on the Network View Map

Table 17 lists the node icons on the network view map.

~

Note  In the mixed configuration node with ONS 15454 and ONS 15454-M6 cards, only the node controller
icon will be displayed in the network view.
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Table 17 Description of Node Icons on Network View Map

Node Name Icon Description

SONET A SONET, SDH, hybrid, or amplified time-division

SDH E”'_ s multiplexing (TDM) node icon is represented as a cylinder
m with crossed arrows.

Hybrid OADM

Hybrid line amplifier
Hybrid terminal
Passive hybrid terminal

Amplified TDM

e A SONET or SDH node can include OC-N cards,
electrical cards, cross-connects, Storage Access
Management (SAM) cards, and Ethernet cards.

¢ A hybrid optical add/drop multiplexing (OADM) node
contains at least one AD-xC-xx.x card or one AD-xB-xx.x
card and two
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards.
TDM cards can be installed in any available slot. Hard
reset can be done on a TNC/TNCE/TSC/TSCE cards.

¢ A hybrid line amplifier node contains amplifiers and both
TDM and dense wavelength division multiplexing
(DWDM) cards.

¢ A hybrid terminal node contains at least one 32MUX-O
card, one 32DMX-O card, amplifiers, two
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, and
TDM cards. Alternatively, the node may contain at least
one 40-MUX-C, one 40-DMX-C card, amplifiers, two
TCC2/TCC2P/TCC3/TNC/TNCE/TSC/TSCE cards, and
TDM cards.

e A passive hybrid terminal node has the same equipment as
the hybrid terminal node, but does not contain amplifiers.

An amplified TDM node is a node that increases the span
length between two ONS 15454 nodes that contain TDM cards
and optical amplifiers. Amplified TDM nodes contain either
OPT-BST amplifiers or AD-1C-xx.x cards.

Hub

A DWDM hub node icon is represented as a three-dimensional
cylinder with amplifiers. A hub node contains one of the
following combinations:

e Two 32MUX-O cards and two 32DMX-O or 32DMX
cards

e Two 32WSS cards and two 32DMX or 32DMX-O cards
e Two 32WSS-L cards and two 32DMX-L cards

e Two 40-WSS-C or 40-WSS-CE cards and two 40-DMX-C
or 40DMX-CE cards

e Two 40-SMR1-C or 40-SMR2-C cards and two
15216-MD-40-ODD cards

No OADM cards are provisioned in a hub node.
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Table 17 Description of Node Icons on Network View Map (continued)

Node Name

Icon

Description

OADM

i

A DWDM OADM node icon is represented as a
three-dimensional cylinder with arrows. An OADM node
contains at least one AD-xC-xx.x card or one AD-xB-xx.x
card. No 32MUX-O, 32DMX-0, 32DMX, 40-MUX-C, or
40-DMX-C cards are provisioned.

~

Note  The 32MUX-O and 32DMX-O cards are not supported
in M2.

ROADM

1

A reconfigurable OADM (ROADM) node icon is represented
as a three-dimensional cylinder with two amplifier symbols
that have arrows between them. A ROADM node contains one
of the following combinations:

e Two 32WSS cards and, optionally, two 32DMX or
32DMX-O cards

e Two 32WSS-L cards and, optionally, two 32DMX-L cards

e Two 40-WSS-C or 40-WSS-CE cards and, optionally, two
40-DMX-C or 40-DMX-CE cards

e Two 40-SMR1-C or 40-SMR2-C cards and two
15216-MD-40-ODD cards

e Two 80-WXC-C and two 15216-MD-40-ODD or
15216-MD-40-EVEN units

Transponders (TXPs) and muxponders (MXPs) can be
installed in Slots 6 and 12. If amplification is not used, TXPs
or MXPs can be installed in Slots 1 and 17. If OPT-BSTs are
not installed, OSC-CSM cards are installed in Slots 2 and 16
and Slots 8 and 10 are empty.

Terminal

1

A terminal node is represented as a three-dimensional cylinder
with a white rectangle in the center. A terminal node contains
one of the following combinations:

e One 32MUX-O card and one 32DMX-O card

e One 32WSS card and either a 32DMX or a 32DMX-O
card

e One 32WSS-L card and one 32DMX-L card

e One 40-WSS-C or 40-WSS-CE card and one 40-DMX-C
or 40-DMX-CE card

¢ One 40-MUX-C and one 40-DMX-C or 40-DMX-CE card

¢ One 40-SMR1-C or 40-SMR2-C card and one
15216-MD-40-ODD card

e 80-WXC-C and one 15216-MD-40-ODD and one
15216-MD-40-EVEN

e A flexible terminal node contains a series of OADM and
amplifier cards.
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Table 17 Description of Node Icons on Network View Map (continued)
Node Name lcon Description
Line Line and OSC regeneration line nodes are represented as a

OSC regeneration line

E s three-dimensional cylinder with one arrow pointing west and
another arrow pointing east.

¢ A line node has only OPT-PRE or OPT-BST amplifiers
provisioned.

e An optical service channel (OSC) regeneration line node
contains two OSC-CSM cards.

Unknown

An unknown DWDM node icon is represented as a

Eﬂ three-dimensional cylinder with one arrow pointing north. An
unknown node means that the provisioned cards do not allow

the node to fit any of the defined DWDM node categories.

Manage the CTC Window

Different navigational methods are available within the CTC window to access views and perform
management actions. You can double-click and right-click objects in the graphic area and move the
mouse over nodes, cards, and ports to view popup status information.

CTC Menu and Toolbar Options

The CTC window menu bar and toolbar provide primary CTC functions. Table 18 shows the actions that
are available from the CTC menu and toolbar.

Table 18 CTC Menu and Toolbar Options
Menu Menu Option Toolbar  |Description
File Add Node _ Adds anode to the current session. See the “DLP-G49 Add a Node to the Current
ﬁ Session or Login Group” task.

Delete Selected Deletes a node from the current session.

Node EI

Lock CTC Locks CTC without closing the CTC session. A user name and password are

| ﬂ I required to open CTC.

Print Ij Prints CTC data. See the “DLP-G113 Print CTC Data” task.

Export Ij Exports CTC data. See the “DLP-G114 Export CTC Data” task.

Exit Closes the CTC session.

i
PCTC Operation, Information, and Shortcuts

I oL-25021-01 .m


http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_5BA476C365674FE695AC31D69B082B7C
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_454d_ctcoperation.html#task_5BA476C365674FE695AC31D69B082B7C
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html#task_3D985C3777014699B811B538ABD0C71C
http://www.cisco.com/en/US/docs/optical/15000r/dwdm/configuration/guide/b_alarm_tca_monitoring.html#task_F495D4808D46428A8832FB703A17E640

B  Manage the CTC Window

Table 18 CTC Menu and Toolbar Options (continued)
Menu Menu Option Toolbar  |Description
Edit Preferences Displays the Preferences dialog box, which shows the following tabs:
| Pﬁl I e General—Allows you to change event defaults and manage preferences.
e Login Node Groups—Allows you to create login node groups. See the
“DLP-G48 Create Login Node Groups” task.
e Map—Allows you to customize the network view. See the “DLP-G168
Change the Network View Background Color” task and the “DLP-G170
Apply a Custom Network View Background Map” task.
e Circuit—Allows you to change the color of circuit spans. This task is not
applicable on DWDM-only nodes.
e Firewall—Sets the Internet Inter-ORB Protocol (IIOP) listener ports for
access to the ONS 15454 through a firewall. See the “NTP-G27 Set Up the
ONS 15454 for Firewall Access” task in the chapter “Turn Up a Node” of
the Cisco ONS 15454 DWDM Configuration Guide.
e JRE—Allows you to select another Java Runtime Environment (JRE)
version. See the “DLP-G52 Change the JRE Version” task.
View Go To Previous View Displays the previous CTC view. Available only after you navigate to a next

view.

Go To Next View

Displays the next CTC view. Go to Previous View and Go to Next View are
similar to forward and backward navigation in a web browser.

Go To Parent View

o] g &

References the CTC view hierarchy: network view, multishelf view (multishelf
mode), node view (single-shelf mode), shelf view (multishelf mode), and card
view. In card view, this command displays the node view (single-shelf mode) or
shelf view (multishelf mode); in node view (single-shelf mode) or multishelf
view (multishelf mode), the command displays network view. Not available in
network view. In shelf view (multishelf mode), this command displays
multishelf view.

Go To Selected
Object View

Displays the object selected in the CTC window.

Go To Home View

g &

Displays the login node in node view (single-shelf mode) or multishelf view
(multishelf mode). If the login node is a multishelf node controller, the
multishelf view displays.

Go To Network View Displays the network view.
Go To Other Node Displays a dialog box allowing you to type in the node name or IP address of a
] a network node that you want to view.

Show Status Bar

Click this item to display or hide the status bar at the bottom of the CTC window.

Show Tool Bar

Click this item to display or hide the CTC toolbar.
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Table 18 CTC Menu and Toolbar Options (continued)
Menu Menu Option Toolbar  |Description
Tools Circuits — Displays the following options:

Repair Circuits—Repairs incomplete circuits following replacement of the
ONS 15454 alarm interface panel (AIP). Refer to the Cisco ONS 15454
DWDM Troubleshooting Guide for more information.

Reconfigure Circuits—Allows you to reconfigure circuits. Not applicable to
DWDM nodes.

Set Path Selector Attributes—Allows you to edit path protection or
subnetwork connection protection (SNCP) circuit path selector attributes.
Not applicable to DWDM nodes.

Set Circuit State—Allows you to change a circuit state. Not applicable on
DWDM nodes.

Roll Circuit—Allows you to reroute live traffic without interrupting service.

Delete Rolls—Removes rolls that are not deleted by CTC after a roll has
been completed.

Upgrade OCHNC—(ONS 15454 only) Upgrades OCHNCs created in
earlier software releases to OCHCCs. Refer to the Cisco ONS 15454 DWDM
Configuration Guide for more information.

Show RPR Circuit Ring—Shows the RPR ring for the circuit selected on the
Circuits window.

Overhead Circuits

(SONET and SDH only) Displays the Repair IP Tunnels option, which fixes
circuits that are in the PARTIAL status as a result of node IP address changes.

Links

Displays the following options:

Repair PPCs option that launches the PPC Repair wizard. The PPC Repair
wizard fixes PPC termination in cases where the IP address changes for one
node connected by one link. It will also discover the IP address change
based on information stored by the PPC terminations.

Repair server trails that launches the Server Trail Repair wizard. The repair
server trails option repairs server trail terminations in cases where the IP
address changes for a node connected by a Server Trail link.

Topology Upgrade

Displays the following options:

Convert Path Protection to BLSR (or Convert SNCP to
MS-SPRing)—Converts a path protection configuration to a bidirectional
line switch ring (BLSR) or an SNCP to a multiplex section-shared
protection ring (MS-SPRing). Not applicable to DWDM nodes.

Convert Unprotected to Path Protection (or SNCP)—Converts a
point-to-point or linear add/drop multiplexer (ADM) to path protection or
SNCP. Not applicable to DWDM nodes.

Manage IPoDWDM

Displays the following options:

SRLG Report
— Consolidated SRLG Report
— Detailed SRLG Report
Manage SRLGs
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Table 18

CTC Menu and Toolbar Options (continued)

Menu Option

Toolbar

Description

Window

Reset to Default

=l

Restores the default view position. This option can be accesed from any
perspective to go back to the default initial position of any added view. After
deleting a customized view, the view goes back to default position.

Perspective

Add Perspective—Opens the add perspective dialogue box to create a new
custom perspective. Is it possible to add views for those network elements only
on the networks that support perspective feature.

Remove Perspectives—Opens a remove perspectives dialog box, where you can
choose the perspective you want to delete. You can not delete the active default
CTC view.

Remove Active Perspectives—Deletes the current customized perspective. you
cannot delete the active default CTC perspective.

&>
Show Network — Displays the network explorer pane.
Explorer
Show Summary — Displays the summary pane.
Show Main Tabbed |— Displays the pane with all tabs.
View
Help Contents and Index |— Displays the online help window.
User Manuals — Displays the Cisco ONS 15454 documentation.
About CTC — Displays the software version and the nodes in the CTC session.

— Network Scope — Displays the selected network scope. The network scope drop-down list has
three options: DWDM, TDM, or All. If you choose DWDM, DWDM and hybrid
nodes appear on the network view map. If you choose TDM, TDM and hybrid
nodes appear on the network view map. If you choose All, every node on the
network appears on the network view map.

— Link Filter Opens the Link Filter dialog box, which allows you to choose which link classes

o appear on the nondetail network map. The available classes vary according to

the selected network scope.
e ALL—DCC, GCC, OTS, PPC
¢ DWDM—GCC, OTS, PPC
e TDM—DCC, PPC

(Toolbar only) Zooms out the network view area.

(Toolbar only) Zooms in the network view area.

lal
@l
=

(Toolbar only) Zooms in a selected network view area.
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Table 18 CTC Menu and Toolbar Options (continued)

Menu Menu Option

Toolbar

Description

4

A

Opens the CTC Alerts dialog box, which shows the status of certain CTC
background tasks. When the CTC Alerts toolbar icon contains a red triangle,
unread notifications exist. When there are no unread notifications, the CTC
Alerts toolbar icon contains a gray triangle (see the icons in the Toolbar column
for comparison). Notifications include:

e Network disconnection.

¢ Send-PDIP inconsistency—CTC discovers a new node that does not have a
SEND-PDIP setting consistent with the login node.

e Circuit deletion status—Reports when the circuit deletion process
completes if you chose “Notify when complete” as described in the
“DLP-G106 Delete Optical Channel Network Connections” task and the
“DLP-G347 Delete Optical Channel Client Connections” task in the chapter
“Create Optical Channel Circuits and Provisionable Patchcords” of the
Cisco ONS 15454 DWDM Configuration Guide. The CTC Alerts window
always reports circuit deletion errors.

e Conditions retrieval error.
e Software download failure.

You can save a notification by clicking the Save button in the CTC Alerts dialog
box and navigating to the directory where you want to save the text file.

By default, the CTC Alerts dialog box appears automatically. To disable
automatic popup, see the “DLP-G53 Configure the CTC Alerts Dialog Box for
Automatic Popup” task.

Changes between fixed and floating panes.

n

— — Click Toggle auto-hide to hide the pane.
=]

— — Closes the pane.
ks

CTC Mouse Options

In addition to the CTC menu bar and toolbar, you can invoke actions by double-clicking CTC window
items with your mouse, or by right-clicking an item and selecting actions from shortcut menus. Table 19
lists the CTC window mouse shortcuts.
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Table 19

CTC Window Mouse Shortcuts

Technique

Description

Double-click

Node in network view—Displays the node view (single-shelf mode) or
multishelf view (multishelf mode) view.

Domain in network view—Displays the domain view.
Shelf in multishelf view—Displays the shelf view.

Card in node view (single-shelf mode) or shelf view (multishelf
mode)—Displays the card view.

Alarm/Event—Displays the object that raised the alarm or event.

Circuits—Displays the Edit Circuit window.

Right-click

Network view graphic area—Displays a shortcut menu that you can use to
create a new domain; change the position and zoom level of the graphic
image; save the map layout (if you have a Superuser security level); reset
the default layout of the network view; set, change, or remove the
background image and color; collapse and expand links; and save or reset
the node position.

Domain in network view—Displays a shortcut menu that you can use to
open a domain, show the domain overview, rename the domain, and delete
the domain.

Node in network view—Displays a shortcut menu that you can use to open
the node, reset the node icon position to the longitude and latitude that is set
on the Provisioning > General tab, delete the node, fix the node position for
automatic layout, provision circuits, provision channels, and update circuits
or channels with a new node.

Multishelf view (multishelf mode)—Right-clicking over an existing shelf
displays a shortcut menu that you can use to open or delete a shelf.
Right-clicking over an empty space in a rack displays a shortcut menu that
allows you to add a shelf. Right-clicking over an empty space that is outside
of a rack displays a shortcut menu that you can use to add a new rack.
Right-clicking over the rack number displays a shortcut menu that you can
use to delete a rack.

Span in network view—Displays a shortcut menu that you can use to view
information about the span’s source and destination ports, the protection
scheme, and the optical or electrical level. You can display the Circuits on
Spans dialog box, which displays additional span information. You can also
expand and collapse links.

Card in node view (single-shelf mode) or shelf view (multishelf
mode)—Displays a shortcut menu that you can use to open, delete, reset,
and change cards. The card that you choose determines the commands that
appear.

Card in card view—Displays a shortcut menu that you can use to reset the
card, or go to the parent view (node view).

Empty slot in node view (single-shelf mode) or shelf view (multishelf
mode)—Displays a shortcut menu with cards that you can choose to
preprovision the slot.
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Table 19

Manage the CTC Window

CTC Window Mouse Shortcuts (continued)

Technique

Description

Move mouse cursor | ® Over node in network view—Displays a summary of node alarms and

provides a warning if the node icon has been moved out of the map range.

e Over span in network view—Displays circuit (node, slot, port) bandwidth
and protection information. For DWDM spans, the span loss optical
direction and optical ring ID appear. If the span terminates on the trunk port
of a transponder (TXP) or muxponder (MXP) card, the associated DWDM
wavelength also appears.

e Over domain in network view—Displays domain name and the number of
nodes in the domain.

e Over card in node view (single-shelf mode) or multishelf view (multishelf
mode)—Displays card type, card status, alarm profile status and, depending
on the DWDM card type, number of bands or channels.

e Over card port in node/shelf view—Displays port number and/or name, port
service state, and alarm profile status.

e Over card port in card view—Displays port name (if applicable), port
service state, protection status (if applicable), and alarm profile status. For
DWDM cards, the port number is labeled as channel, band, or line
depending on the card type along with the port state and alarm profile status.

Multishelf View Shortcuts

Table 20 shows actions on ONS 15454 cards that you can perform by moving your mouse over the CTC
window in multishelf view (multishelf mode).

Table 20

Multishelf View Card-Related Shortcuts

Action

Shortcut

Display card
information

In multishelf view (multishelf mode), move your mouse over cards in the
graphic to display tool tips with the card type, card status (active or standby),
the highest level of alarm (if any), and the alarm profile used by the card.

Node View (Single-Shelf Mode) and Shelf View (Multishelf Mode) Shortcuts

Table 21 shows actions that you can perform by moving your mouse in the CTC window in node
(single-shelf mode) or shelf (multishelf mode) view.
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Table 21 Node/Shelf View Card-Related Shortcuts

Action

Shortcut

Display card
information

In node view (single-shelf mode) or shelf view (multishelf mode), move your
mouse over cards in the graphic to display tool tips with the card type, card
status (active or standby), the highest level of alarm (if any), and the alarm
profile used by the card.

Open, reset, or delete
a card

In node view (single-shelf mode) or shelf view (multishelf mode), right-click
a card. Choose Open Card to display the card in card view, Delete Card to
delete it, or Reset Card to reset the card.

It is recommended that the card be physically removed from its slot before
deleting it from CTC.

Preprovision a slot

In node view (single-shelf mode) or shelf view (multishelf mode), right-click
an empty slot. Choose the card type for which you want to provision the slot
from the shortcut menu.

Change a card

In node view (single-shelf mode) or shelf view (multishelf mode), right-click
an OC-N card or a DS3 card, and choose Change Card. In the Change Card
dialog box, choose the card type. Change Card retains all card provisioning,
including data communications channel (DCC) terminations, protection,
circuits, and rings.

Network View Tasks

Right-click the network view graphic area or a node, span, or domain to display shortcut menus. Table 22
lists the actions that are available from the network view.

Table 22 Network Management Tasks in Network View

Action

Task

Open a node

Any of the following:
¢ Double-click a node icon.
¢ Right-click a node icon and choose Open Node from the shortcut menu.

¢ Click a node and choose Go To Selected Object View from the View
menu.

¢ From the View menu, choose Go To Other Node. Choose a node from the
Select Node dialog box.

¢ Double-click a node alarm or event in the Alarms or History tab.

Move a node icon

Press and hold the left mouse button to drag the node icon to a new location.

Reset node icon
position

Right-click a node and choose Reset Node Position from the shortcut menu.
The node icon moves to the position defined by the longitude and latitude fields
on the Provisioning > General tab in node view (single-shelf mode) or
multishelf view (multishelf mode).

Consolidate links

Right-click on a link and choose Collapse OTS Links from the shortcut menu.
For more detailed instructions, refer to Manage the Node.
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Table 22

Manage the CTC Window

Network Management Tasks in Network View (continued)

Action

Task

Provision a circuit

e Right-click a node. From the shortcut menu, choose Provision Circuit To
and choose the node where you want to provision the circuit. For circuit
creation procedures, see the chapter “Create Optical Channel Circuits and
Provisionable Patchcords” in the Cisco ONS 15454 DWDM Configuration
Guide.

Update circuits with
new node

Right-click a node and choose Update Circuits With New Node from the
shortcut menu. Use this command when you add a new node and want to pass
circuits through it.

Display a link end
point

Right-click a span. From the shortcut menu, choose Go To {<node> | <port>
| <slot>} for the drop port you want to view. CTC displays the card in card
view.

Display span
properties

Do any of the following:
e Move the mouse over a span; the properties appear near the span.
¢ Click a span; the properties appear in the upper left corner of the window.

¢ Right-click a span; the properties appear at the top of the shortcut menu.

Perform a Path
Protection (ANSI) or
SNCP (ETSI)
protection switch for
an entire span

Right-click a network span and click Circuits. In the Circuits on Span dialog
box, switch options appear in the Path Protection (or SNCP) Span Switching
field.

Display DWDM span
properties

Right-click a DWDM network span and choose Circuits from the shortcut
menu. The optical channel network connection (OCHNC), optical direction,
and circuit appear.

Upgrade a span

Right-click a span and choose Upgrade Span from the shortcut menu. Not
applicable to DWDM nodes.

Table Display Options

Right-clicking a table column displays a shortcut menu. Table 23 shows table display options, which
include rearranging or hiding CTC table columns and sorting table columns by primary or secondary

keys.
Table 23 Table Display Options
Task Click Right-Click Shortcut Menu

Resize column

Click while dragging the column |—
separator to the right or left.

Rearrange column order |Click while dragging the column |—

header to the right or left.

Reset column order

— Choose Reset Columns Order/Visibility.

Hide column

— Choose Hide Column.

Show column

— Choose Show Column > column_name.
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Table 23 Table Display Options (continued)

Task Click Right-Click Shertcut Menu

Display all hidden — Choose Reset Columns Order/Visibility.
columns

Sort table (primary) Click a column header; each Choose Sort Column.

click changes sort order
(ascending or descending).

Sort table (secondary Press the Shift key and Choose Sort Column (incremental).
sorting keys) simultaneously click the column
header.
Reset sorting — Choose Reset Sorting.
View table row count — View the number after “Row count=" (it is

the last item on the shortcut menu).

Equipment Inventory

In node view (single-shelf mode) and multishelf view (multishelf mode), the Inventory tab displays
information about the ONS 15454 equipment, including:

~

Note

Location—TIdentifies where the equipment is installed, either chassis or slot number.

Eqpt Type—Displays the type of equipment.

CTC lists the 12 passive inventory ports for the M6 chassis in the format

USBP_SIDE_PORT (for example, CTC displays USBP_A_1 for port 1 on the left side of the
chassis, and USBP_B_1 for port 1 on the right side of the chassis). These are labeled on the M6
chassis from 1-12.

Actual Eqpt Type—Displays the specific card name.

Admin State—Changes the card service state unless network conditions prevent the change. For
more information about card administrative states, refer to the “Administrative and Service States”
document.

— IS (ANSI) or Unlocked (ETSI)—Puts the card in the In-Service and Normal (IS-NR [ANSI]) or
Unlocked-enabled (ETSI) service state.

— OOS,MA (ANSI) or Locked,maintenance (ETSI)—Puts the card in the Out-of-Service and
Autonomous, Maintenance (OOS-AU,MT [ANSI]) or Unlocked-disabled,maintenance (ETSI)
service state.

Service State—Displays the current card service state, which is an autonomously generated state
that gives the overall condition of the card. Service states appear in the format: Primary
State-Primary State Qualifier, Secondary State. For more information about card service states, refer
to the “Administrative and Service States” document.

HW Part #—Displays the hardware part number; this number is printed on the top of the card or
equipment piece.

HW Rev—Displays the hardware revision number.

Serial #—Displays the equipment serial number; this number is unique to each card.
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Facilities View W

e CLEI Code—Displays the Common Language Equipment Identifier code.
e Bootroom Rev—Displays the boot read-only memory (ROM) revision number.

e Product ID—Displays the manufacturing product identifier for a hardware component, such as a fan
tray, chassis, or card. The Product ID column displays “N/A” for equipment existing before
Software Release 4.6.

e Version ID—Displays the manufacturing version identifier for a fan tray, chassis, or card. The
Version ID column displays “N/A” for equipment existing before Software Release 4.6.

Buttons at the bottom of the Inventory tab are used to delete or reset a card when a card is selected, or
to delete a PPM if a PPM is selected on the table.

Note  After the card is upgraded using the boot code upgrade procedure, the bootstrap version is displayed in
the Inventory tab in CTC. However, the boot code version is not displayed.

Facilities View

In node view (single-shelf mode), shelf view (multishelf mode), and multishelf view (multishelf mode),
the Maintenance > DWDM > All Facilities tab displays facility information for all facilities on the
ONS 15454 equipment:

e Marked—Displays a check mark if you have designated the facility for logical grouping. For
information on marking a facility to group it with others, see the “NTP-G166 View the Facilities”
task in the chapter “Maintain the Node” of the Cisco ONS 15454 DWDM Configuration Guide.

¢ Location—Displays the slot number, slot type, port number, and port type of the facility.
e Admin State—Displays the administrative state of the facility.
e Service State—Displays the service state of the facility.

e Power—Displays the power level of the facility.

Additional References

Table 24 references related documents of different releases.

Table 24 Related Documents of Different Releases
Release Documents
Release 9.3 Cisco ONS 15454 DWDM Configuration Guide, Release 9.3

Network Element Defaults, Release 9.3

Cisco ONS 15454 DWDM Troubleshooting Guide, Release 9.3
Release 9.4 Cisco ONS 15454 DWDM Configuration Guide, Release 9.4
Network Element Defaults, Release 9.4

Cisco ONS 15454 DWDM Troubleshooting Guide, Release 9.4
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